Microsoft Access is a relational database application. It is the perfect tool when you begin to outgrow your data collection in Excel. With Access, you can obtain better collection results by creating user-friendly forms with rules to protect the validity of your data. You can create queries to analyze and filter your data, and reports that can be regenerated anytime you need them. Topics for this workshop include database concepts, planning a database, and a hands-on introduction to tables, queries, forms, and reports.
What is a Database?
A variety of definitions exist for a database; but essentially it's a collection of information. A filing cabinet, a Rolodex, a library card catalog, and even the Internet are all types of databases.

Most often the word "database" is used to describe a collection of related "data" (information) stored on computers. An electronic database should allow you to store, sort, and retrieve data. You can create simple databases by creating a Word table or an Excel spreadsheet.

For example, here we have simple database of our patients:

<table>
<thead>
<tr>
<th>MedRec#</th>
<th>First Name</th>
<th>Last Name</th>
<th>DOB</th>
<th>Doctor</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Jack</td>
<td>Nimble</td>
<td>06/08/72</td>
<td>Edwards</td>
</tr>
<tr>
<td>987-654</td>
<td>Jill</td>
<td>Pail</td>
<td>08/27/65</td>
<td>Lewis</td>
</tr>
<tr>
<td>753-951</td>
<td>Mary</td>
<td>Bluebell</td>
<td>12/08/51</td>
<td>Edwards</td>
</tr>
</tbody>
</table>

Here is a simple database of our doctors:

<table>
<thead>
<tr>
<th>EmpID #</th>
<th>First Name</th>
<th>Last Name</th>
<th>Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>999-999</td>
<td>Ken</td>
<td>Edwards</td>
<td>555-1234</td>
</tr>
<tr>
<td>888-888</td>
<td>Laura</td>
<td>Lang</td>
<td>555-4567</td>
</tr>
<tr>
<td>777-777</td>
<td>Yolanda</td>
<td>Lewis</td>
<td>555-7890</td>
</tr>
</tbody>
</table>

Why use Microsoft Access?
Microsoft Access is a "relational" database application. Relational means we can link together sets of data, we can relate the data. We can keep track of the patients, the doctors and when the patients last saw their doctors, what happened at each visit and so on. Access allows us to relate our data, without the repetition that may occur anywhere else.

In an Access database, we can create both of the datasets and link them.

<table>
<thead>
<tr>
<th>MedRec#</th>
<th>First</th>
<th>Last</th>
<th>DOB</th>
<th>Doctor</th>
<th>EmpID #</th>
<th>First</th>
<th>Last</th>
<th>Phone#</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Jack</td>
<td>Nimble</td>
<td>06/08/72</td>
<td>Edwards</td>
<td>999-999</td>
<td>Ken</td>
<td>Edwards</td>
<td>555-1234</td>
</tr>
<tr>
<td>987-654</td>
<td>Jill</td>
<td>Pail</td>
<td>08/27/65</td>
<td>Lewis</td>
<td>888-888</td>
<td>Laura</td>
<td>Lang</td>
<td>555-4567</td>
</tr>
<tr>
<td>753-951</td>
<td>Mary</td>
<td>Bluebell</td>
<td>12/08/51</td>
<td>Edwards</td>
<td>777-777</td>
<td>Yolanda</td>
<td>Lewis</td>
<td>555-7890</td>
</tr>
</tbody>
</table>

In Access the data is saved in Tables. As the data in the Tables change, the rest of the Access database will reflect the newest information (i.e. the Queries, Forms and Reports).

Queries show the data in a Table format. A Query can pull from multiple Tables and allow you to limit the records (rows) display by using criteria and showing only the fields (columns) you want. We can find the phone number for Jill Pail's Doctor, and provide Ken Edwards with a list of his patients.

Forms can be created to provide a "user-friendly" side to your database. They are used to view and enter your data in an interactive formatted structure. Forms are also used to make menus and search windows that turn a simple data collection tool into a more interactive user-friendly application.

Reports are created to print out your data in a formatted structure. They allow you to group and organize your data. They can be used to create Form letters and mailing labels. Access works beautifully with Word for mail merges, but the Reports tool allows for the multi-level summaries.
Planning the Database

The most important part of creating a relational database is **planning**. This can be difficult when you are first learning to use Microsoft Access. Here are some questions that may help:

1. Input - What data do I already have for the database?
2. Output - What information do I want to get out of the database?
3. Process - What do I need to do to get there?

Sometimes it helps to plan the final Reports that you want from your database. For example, we want to have a chart of how many patients attended their appointments. Do we track the 'cancellations' vs. the 'no shows'? What about the late arrivals and the rescheduled? If we want to differentiate, we need to make sure we are going to collect that data. This is why it’s so important to plan everything, to try to predict the "what ifs" that may occur once you have your data collected.

The Tables are the core of your Access database; these structures store the data. Tables are essential to using any of the other Access Tools. When planning out your database try to remember the basic design rules for your Tables.

**Design Rules**

**Organizing Data**

Once you have an idea of the data you would like to collect, you need to decide how many tables you might want to use to organize the data efficiently. In Excel, we might keep several numbered columns to keep track of things, i.e. Medication1, Medication 2..., but in Access we should create a second table to track the numbered fields.

**No Derived Fields**

By using the relationships between our data sets, we can derive missing data. If we are creating a new appointment for a patient, we only need to put in their Medical Record Number (or other unique identifier). The patient's name, phone number, and other information can be derived from the Patient Table.

**Data is broken down into Smallest Logical Parts**

Pulling fields together in Access is often simple; pulling them apart usually requires human intervention. Think of this as breaking up the data into its smallest *sort-able* part.

**Descriptive Field Names**

It's tempting to use abbreviations when we are creating our data tables, but if the title we use is too vague or too abbreviated we may not be able to recall why we created that field. DOB – Date of Birth or Department of Babies? SSN – Social Security Number or Shands System Number?

**Unique Field Names**

Be sure to differentiate between the field names in each Table. We can have a 'First Name' in our Patient Table and a 'First Name' in our Doctor Table but this can lead to confusion when we try to pull both Tables into one database object.

**No Calculated Fields**

In Microsoft Excel, we can perform our calculations on the same sheet as our data, but a Table in Access is stagnant data, it does not change unless you make it change. Access will let you create calculations in Queries, Forms and Reports. Newer versions of Access do have a Calculated field type for the table. This embeds a calculation in the record and is not always reflected in a data entry form.
Unique Records
It's important that each Table has a way to keep records unique. We can do this by setting one field (column) to be a **Primary Key** field. When a field is set as a Primary Key, Access will not allow any duplication nor blanks. When there is not a unique field in your data set, you can use an *AutoNumber*. AutoNumbers are incremented or random fields that are always unique.

**Basic Access Objects**
Access consists of four main database objects: Tables, Queries, Forms, and Reports. Each object has at least two views, Design and "Data". The **Design View** is where we build the structure of that database object. The data view shows the output of the data and is different for each object. Tables and Queries have a **Datasheet View**, Forms have a **Form View**, and Reports have a **Report View**, or a **Print Preview** view. Each kind of object has its own purpose.

*Tables*
Tables store data. The Tables are the true 'database' (base of data). These need to be created and properly linked (related) in order to effectively use the other Access tools. Tables are the core of your database, everything else in Access depends on the Tables.

The **Design View** of a Table allows you to create and modify:

- **Field Names** (the column headings)
- The type of data stored in a field (**Data Type**). In this workshop we use:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Text</td>
<td>Allows any alphanumeric characters, up to 255 characters</td>
</tr>
<tr>
<td>Number</td>
<td>Limited to Numbers only</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Allows Dates and/or Times only</td>
</tr>
<tr>
<td>AutoNumber</td>
<td>Creates a unique number for each record.</td>
</tr>
<tr>
<td>Yes/No</td>
<td>This is a binary field (only two answers, Yes/No, True/False)</td>
</tr>
<tr>
<td>Lookup Wizard...</td>
<td>The lookup wizard allows you to link the field to another Table or to type in a list of your own creation.</td>
</tr>
</tbody>
</table>

- **Descriptions**, which will be displayed in the status bar in the Data view of Forms
- And the **Properties** of each field, such as how many characters can be entered (text field size), or how the data is formatted (05/05/15 or May 5, 2015).
The **Datasheet View** of a Table allows you to create and modify the data within a grid structure based on the settings in the Design View.

![Datasheet View](image)

**Vocabulary**

A collection of fields make up a record. A collection of records make up a Table. A collection of Tables make up a database

- **Field** – One column of a Table common to all the records
- **Record** – One row of a Table containing all data about a particular entry
- **Table** – One set of related data
- **Database** – Structured collection of related Tables

**Queries**

Queries show a selection of data based on criteria (limitations) you provide. Queries can pull from one or more related Tables and/or other Queries.

The **Datasheet View** of a Query looks like a Table. All data added or modified in a Query, will be saved in the Table. The **Design View** is where the structure of the Query is created. This is where we choose the record sources and fields, and set the sort order and criteria.

![Design View](image)
**Forms**
Most Forms display one record at a time, in a formatted user-friendly environment. You can build your Form so it will display multiple records. As you develop Forms you can create navigation buttons, insert graphics, and change the colors to display everything consistently. Forms have three basic views: Design View, Layout View, and Form View.

Your record source can be a Table or Query. If we want to *all* the patients use the Table; if we only want to see Dr. Edward's Patients, use a Query.

The data entered or modified in a Form is automatically saved to the Table. The Table is the true location of the data; the Form is a "pretty" way to view/modify/create the data.

For the Basic Workshop we will use the AutoCreate and Wizard buttons to make our Forms.

We modify our Forms by using the **Layout View** to change the placement and size of the fields, and the **Design View** to add objects like command buttons to move between records, and open other database objects like other Forms and Reports.
Reports

Reports are designed to create an organized output of data from your database. With a Report, you can group and summarize information. You can't edit the data in a Report, but if you make the modifications in the Table, Query, or Form you will see the results when you open the Report again. Reports have four basic views: Report View, Print Preview, Layout View, and Design View.
Class Exercise

Create the Database

1. Open Microsoft Access
2. Choose Blank Desktop Database
3. Click on the yellow folder at the end of the File Name box and browse for the desktop
4. Use the file name: Patient Appointments
5. Click Create

Explore the Window

1. Close Table1 with the X under the ribbon, or by right-clicking on the name of the table
2. Explore the Ribbon
   a. Home tab – Clipboard, Sort & Filter, Spell Check, Refresh Data, Format text
   b. Create – Create a database object: Tables, Queries, Forms, Reports
   c. External Data – Import and Export data
   d. Database Tools – Advanced Features of Relationships and Data Analyzers

Create the Patients Table

1. Click on the Create tab and choose Table Design

2. Type the first Field Name: Pt Med Rec #
   a. Data Type: Short Text, Description: Patient's Medical Record Number
3. Enter in the rest of the fields (descriptions not necessary):

4. Set the Pt Med Rec # to be the key
   a. Click on the big yellow key on the toolbar
5. Save the Table as Patients
Entering First Record

1. Turn to the Datasheet View
2. Enter our first Med Rec #: 123-456
3. Press tab move to the next field

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Phone #</th>
<th>Pt Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Sam</td>
<td>Franks</td>
<td>3525551234</td>
<td>1/1/1</td>
</tr>
</tbody>
</table>

a. First Name: Sam
b. Last Name: Franks
c. Phone #: 3525551234
   - No dashes
d. Birth Date: 1/1/1
   - If you set it as a DATE/TIME field Access will add in the "200" for 2001

Exit the Database

1. Exit the database, Access will probably not ask you to save
   a. But it did save the record, it does so automatically.
2. Open your database from the desktop
   a. If necessary, Enable Content
3. Open the table (double-click) from the navigation pane
   a. Sam is still there!

Rearrange Fields

1. In Design View, move Pt Birth Date above the Pt Phone #
   a. Click on the row heading, the grey box in front of the field name. Then Click/Drag the line above the Pt Phone #
2. Switch to the Datasheet View and Save the table
   a. Data saves itself, structural changes have to be saved manually
3. Enter the next record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Birth Date</th>
<th>Pt Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>789-012</td>
<td>Jacob</td>
<td>Smith</td>
<td>2/2/92</td>
<td>3525554321</td>
</tr>
</tbody>
</table>

a. No hyphens in the phone number

Adding Fields

1. In Design View, create **Pt Gender**, Short Text field, above Pt Birth Date
   a. Insert Rows from Design Tab, or from the right-click menu
2. In Data View, enter "Male" (the whole word) for Sam and Jacob
**Enter a "trouble maker" Record**

1. Enter the next record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>555-555</td>
<td>Jane</td>
<td>Williams</td>
<td>F</td>
<td>March 3, 1983</td>
<td>352-555-5555</td>
</tr>
</tbody>
</table>

a. Enter Gender as just one character

b. Enter birth date as March 3, 1983; it should change to 3/3/1983

c. Type in the hyphens for the phone number

2. Go to the Design view and then return to the Data view

a. Notice Jane’s record moves. This is because by default Access sorts by the primary key field. Since Pt Med Rec # is our key, every time the data is refreshed it will sort the data by the primary key field.

![Patients](Patients.png)

**Modify Field Properties – Field Size**

1. In Design View, set **Field Size** property of Gender at the bottom of the window to be 1

   a. When you save you will get the following warning message saying data may be lost. We want this to happen, click Yes.

   ![Warning Message](Warning.png)

   b. Data is lost, our Male entries should now only read M

**Modify Field Properties – Format**

1. In Design View, set the **Format** property for Pt Birth Date to be a Medium Date

   a. Notice there is no "field size" for a date field, because it doesn’t matter how many characters you type in, as long as it's a valid date.

   b. Access recognizes dashes (1-1-2001) and slashes (1/1/2001) for date formats
Modify Field Properties – Input Mask

1. In Design View, set an Input Mask for the Phone Number
   a. Click in the Input Mask Property for Pt Phone #
   b. Click the Build button (…) at the end of the line to launch the wizard
   c. In the Input Mask Wizard, Phone Number is already selected. Click FINISH.
   d. Save and View Results

2. Fix Jane's Phone Number by taking out the extra dashes

Enter a New Record

1. Enter a new record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>527-594</td>
<td>Doris</td>
<td>Jones</td>
<td>F</td>
<td>4/4/74</td>
<td>3525555432</td>
</tr>
</tbody>
</table>

2. Close the Table

3. Open the Patient’s Table

Create Female Patient’s Query

1. Go to the Create Tab and choose Query Design
2. In the Show Table window, push the **Add** button and then close the window.

3. Double-clicking on the field names to add **Pt First Name**, **Pt Last Name**, and **Pt Gender**.

4. View Datasheet View.

Customizing a Query

1. In the Datasheet view notice the sort order is by Med Rec #.

2. In the Design view, set Query to **Sort by Pt Last Name Ascending**.

3. Go to the Data View, patients should read, Franks through Williams.

4. In the Design View, set the **Criteria** line for the Pt Gender field to be **F**.
   a. In Datasheet view, you should only have two people: Jane and Doris.

5. Close and save the Query as **Female Patients**.
Create Patients Form

1. Select Patients Table from left Navigation Pane so it becomes the default data source

2. On the Create Tab click on the Form button

3. We are in the Form's Layout view
   a. Place your mouse along the right border of the highlighted box and resize

4. Change to the "Form" view (first button on the Home Tab)

5. Create a new FEMALE patient, anyone you want
   a. Tab until you reach a new blank record, or use the NEW button on the Home Tab
   b. Make sure to leave the record, "pencils down!", move to another record or save

6. Open the Patients TABLE, view new person
   a. From the left Navigation Pane, double-click to open

7. Open the Female Patients QUERY, view new person
   a. New patient has been saved, even though the Form has not been saved
   b. If you did not close the table and/or query, you may not see the person right away. Close the object, and when you open them you'll see the new person

8. Close all, Save Form as "Patients"

Notes
Access creates the structure of the form based on the structure of the table at that moment in time. If you make any structural changes like adding a new field, it will not magically appear here, you'll have to go to the design of the form and add it.

Data is saved in the table, and will appear in all the database objects; formatting however can change.

- **GENDER**: Still limited to one character. This is a data property so if we change the number of characters allowed in the table, it will carry through here.

- **BIRTHDATE**: Fields can be formatted differently throughout the database. Once this form has been created you can reformat the date and it will not change the format in any other database object.

- **PHONE #**: As with the format, an input mask is a property that can be changed without changing the formatting in other database objects.
Create Simple Report

1. Select Table from left Navigation Pane so it becomes the default data source
2. On the Create Tab click on the REPORT button
3. The report opens in Layout View, adjust the columns to fit the data
4. Right-click in an empty space and go to the Print Preview
5. Close and Save as Patients

Create Grouped Report

1. Select Patient Table from left Navigation Pane so it becomes the default data source
2. On the Create Tab click on the REPORT WIZARD button
   a. Step 1 (Select fields)
      - Confirm you’re using Table: Patients
      - Use double arrow (>>) to move over all fields
b. Next Step 2 (Grouping) -
   - Group by Pt Last Name,
     - Push the Grouping Options in the bottom left corner of the window and choose "1st Letter"
   - Ungroup all fields (no blue in the left side)
   - Group by Pt Birth Date twice
     - Grouping Options by Month & by Week
   - Ungroup all fields (no blue in the left side)
   - Group by Gender

c. Next Step 3 (sorting)
   - Sort by Last Name and First Name Ascending

d. Next Step 4 (layout)
   - Outline
   - Portrait
   - Adjusting Fields (checked)

e. Next Step 6 (saving)
   - Patients by Gender
Modify the Report
1. Right-click anywhere on the report and go to the layout view
2. Adjust the Pt Birth Date field, stretching toward the Pt Med Rec # field

Create Appointments Table
1. From the Create Tab choose **Table Design**
2. Create Table as shown here
3. Set Appt ID # to be the Primary Key

Create Lookup Location
1. Change the Data Type for Appt Location to be **Lookup Wizard**
   a. Step 1 - I will type in the values I want
   b. **Next Step 2**
      – Gainesville, Starke, Jacksonville
   c. **Next Step 3** – Label Appt Location
   d. **Finish**
2. Appt Location field type still says SHORT TEXT
   a. View Lookup tab in the properties at the bottom of the window
Create Lookup Pt Med Rec #

1. Change the Data Type for Pt Med Rec to be LOOKUP WIZARD

   a. Step 1. How do you want your lookup field to get its values?
      I want the lookup column to look up the values in a Table or Query

   b. Next Step 2. Which table should provide the values for your lookup field?
      **Table: Patients**

   c. Next Step 3. Which fields of the Patients contain the values you want to include in your lookup field?
      **Pt Med Rec #, Pt Last Name, Pt Birth Date**

   d. Next Step 4. What sort order do you want for the items in your list box?
      **Pt Last Name, Pt Birth Date**

   e. Next Step 5. How wide would you like your columns?
      UNCHECK the hide key column

   f. Next Step 6. Which column in your lookup field contains the values you want to store in your database?
      **Pt Med Rec #**

   g. Next Step 7. What label would you like for your lookup field?
      **Pt Med Rec**

   h. Click **Finish**

   i. Click **Yes** to the warning message "The Table must be saved before the relationships can be created"
Add an Appointment

1. In Datasheet view enter a new record
2. Enter a new record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Appt Doctor</th>
<th>Appt Date</th>
<th>Appt Time</th>
<th>Appt Reason</th>
<th>Appt Type First</th>
<th>Appt Type Follow-up</th>
<th>Appt Type Emergency</th>
<th>Appt Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Jekyll</td>
<td>10/17</td>
<td>2p</td>
<td>Mood</td>
<td>X</td>
<td></td>
<td></td>
<td>Gainesville</td>
</tr>
</tbody>
</table>

Modify Appt Table

1. Change CAPTION property for the Yes/No fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appt Type First</td>
<td>First Appt</td>
</tr>
<tr>
<td>Appt Type Follow-up</td>
<td>Follow-up</td>
</tr>
<tr>
<td>Appt Type Emergency</td>
<td>Emergency</td>
</tr>
</tbody>
</table>

2. Change Appt Time FORMAT property to remove the seconds

Create Schedule Query with Multiple Tables

1. Go to the Create Tab and click the **Query Design** button
2. Add both Tables and close the Show Table window
3. Double-click on the field names to add them to the query
   a. Pt Med Rec from APPOINTMENTS
   b. Pt First Name and Pt Last Name from PATIENTS
   c. Appt Doctor, Appt Date, Appt Reason from APPOINTMENTS
Add an Appointment to the Query

1. Add a new record in the Datasheet view
   a. Select the Med Rec for Ms Williams
   b. Change Jane to Janey
   c. Set the Doctor, Date, Time, and Reason

<table>
<thead>
<tr>
<th>Pt Med Rec</th>
<th>Pt First Name</th>
<th>Pt Last Name</th>
<th>Appt Doctor</th>
<th>Appt Date</th>
<th>Appt Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>339-852</td>
<td>Jenny</td>
<td>Williams</td>
<td>Scholls</td>
<td>8/29</td>
<td>Foot Oder</td>
</tr>
</tbody>
</table>

2. Close and Save Query as Schedule

Create Patient Appointment Form

1. Go to the Create Tab and click the FORM WIZARD
   a. Choose the Table: Patients
      – Use the Double Arrow to bring over everything (>>)
   b. DO NOT CLICK NEXT
   c. Choose Table: Appointments
      – Bring over: Appt Doctor, Appt Date, and Appt Reason
   d. Click FINISH - We are skipping the rest of the steps
Using Patient Appointments Form

1. Click in the Pt Last Name field
   a. Click the binoculars to FIND (or press Ctrl-F)
   b. Type in Williams
   c. Schedule another appt for Ms Williams

2. Create a new Patient
   a. Schedule them for an appointment

3. Close and Save the Form
View the Final Results

1. View each object in the database
   a. Your Tables
   b. Your Queries
   c. Your Reports

Backing up Database

1. From the File Tab choose Info
   a. Choose Compact and Repair
      – You should do this every time it crashes, or begins to run slowly, or starts acting funny, or before you share it

2. From the File Tab choose Save & Publish
   a. Under advanced choose Back up Database
      – You should do this on a regular basis, but definitely before you make any major changes,

3. Exit Access
   a. Right-Click on File, Choose "Send to Compressed Zipped Folder"
      – If you would like to email yourself the file, email the "Zipped Folder"

      – The Access Database inside the zipped folder is READ ONLY, meaning you cannot make changes to it. If you want to make the file editable, you will need to drag it out of the zipped folder.

Congratulations, you now know enough to be dangerous.
**Bonus Exercise**

All data is stored in the tables. If you need to enter data, and it doesn't exist on your data entry form, you HAVE to make a storage space, a field, within the table where that data point will be saved.

The following exercise walks you through creating a new field in the Patient's table and adding it to a query and a form.

In the most basic sense:

- Tables store the data
- Queries give you a subset of the data
- Forms are used for data entry
- Reports are used for creating organized printouts

**Add a new field to the database**

1. Open the Patient's Table in Design view
   
   a. Click in the Pt Last Name Field
   
   b. Insert a row from the ribbon or right-click menu
   
   c. Name the new field Pt Middle Name, as a Short Text field
   
   d. Close and Save the table

   ![Image of a table with fields](image)

2. Open the Female Patients Query in Design view

   a. Drag the new Pt Middle Name field into the bottom half of the window

   - If you drop it onto the Pt Last Name field, it will drop in between Pt First Name and Pt Last Name

   ![Image of a query with fields](image)
b. Go to the Datasheet view of the query

c. Give Janey a middle name

d. Close and **Save** the query

3. Open the Patients form in design view

   a. In the ribbon, on the Design tab click the Add Existing Fields button

   b. Drag **Pt Middle Name** between the **Pt First Name** and **Pt Last Name**

   c. Close and **Save** the form